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ABSTRACT 

A MODEL STAFF DEVELOPMENT PROGRAM IN 

TECHNOLOGY SKILLS FOR SELECTED 

SECONDARY SCHOOLS 

By 

Suzanne Keil 

April, 2002 

The relationship between staff professional development in technology that enhanced 

staff efficiencies were studied. A model staff development program in technology has 

been developed to make connections between teacher's readiness and their mastery of 

technology skills. Research has been obtained that indicated a direct correction between 

teachers' readiness in technology and their implementation of technology into the 

classroom. Secondary teachers must be taught using inservices, practice skills and given 

opportunities to share their experiences with colleagues. Administrators must take 

leadership in developing and supporting a quality technology training program that 

recognizes the staffs' individualized needs. 
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CHAPTER ONE 

BACKGROUND OF THE PROJECT 

Introduction 

"There is little question that technology plays important role in our schools. It 
is considered to be the wave of the future so, naturally, teachers are encouraged 
to embrace it. They are encouraged to integrate technology into their lesson 
plans, they are told that technology is an indispensable tool for learning. But 
are all teachers ready to use technology in their classroom?" (Jones, 2001, p. 43). 

As explained by Jones in the above statement, the main problems in preparing 

students today in schools were the limited or inadequate staff development, the time to 

provide training and the ability to learn on behalf of the teacher. 

Day (1996) emphasized that to enhance teaching and learning in classroom instruction 

by using technology, teachers needed to discover and experiment with how to use 

technology and its resources. He also emphasized the importance of technology: 

"Given the nation's interest in improving education, the lack of attention to 
teachers and technology is ironic; especially since those who oversee the daily 
activities of the classroom-the teachers- are at the center of effective use of 
instructional technologies by students" ( p. 42). 

Computer technology, many educators believe, represented the solution to a plethora 

of problems. It promised teachers new ways of accomplishing tasks and of teaching the 

skills that students need to learn (Kearsley, Hunter, & Furlong, 1992). Yet, technology 

has not reached its potential in schools largely because, many of American's teachers 

were reluctant to make the move from traditional teaching methods to teaching with 

computers (Senese, 1984; Hannifin, Dalton & Hooper, 1987). 
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Purpose to the Project 

The purpose of the project was to develop a model staff development program in 

technology skills training for secondary level. To accomplish this purpose a review of 

related literature and research was conducted. Additional related information from 

selected sources were obtained and analyzed. 

Limitations of the Project 

For purposes of the project, it was necessary to establish the following limitations: 

I. Scope: The model staff development program in technology was designed for 

use in grades seven-twelve by selected private or public school districts. 

2. Research: The review of related literature was limited primarily to research 

conducted within the last ten (I 0) years. Related information from selected 

sources was limited to information obtained from ten (10) public and private 

schools 

3. Target Population: The model staff development training program in 

technology was designed for use in grades 7-12. 

Definition of Terms 

Significant terms used in the context of this study have been defined as 

follows: 

1. Digital Divide: Significant difference in the access to and equity of 

technology experience based on categories such as race, gender, 

location, or education. 
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2. Educational Technologies: Computer software-computer applications 

that may incorporate the use of multimedia in on educational setting. 

3. Multimedia: Seamless digital integration of text, graphics, animation, 

audio, still images, and motion videos in a way that provides 

individual users with high levels of control and interaction. 

4. Private School: A school directed and supported by private 

individuals rather than by governmental agencies and funds. 

5. Professional Development: To grow or progress in the teaching field 

from the basis skill level to a mature level. 

6. RAM: An acronym for Random Access Memory. It is the working 

areas of the computer. It is where the program interacts with data to 

create letters, spreadsheets, graphs, etc. 

7. ROM: An acronym for Read Only Memory. It is permanent, start-up 

information in the computer's main system board. 

8. Technology: The methods and materials used in applying scientific 

knowledge to expand human potential to improve and control the 

world. 



CHAPTER TWO 

A REVIEW OF RELATED LITERATURE AND 

INFORMATION OBTAINED FROM SELECTED SOURCES 

Introduction 

The review of research, literature and information summarized in Chapter two has 

been organized in the following manner and addresses: 

1. Current Research in Educational Technology 

a. Need for Staff Development 

b. StaffTraining 

c. Budget for Training 

d. Access to Technology 

2. Summary of Information Obtained from Selected Sources 

3. Summary 

Data current within the last ten (I 0) years was identified through Educational 

Resources Information Center (ERIC) and Internet computer search. Additionally, 

resources from selected sources were obtained and analyzed. 

Current Research in Educational Technology 

More than three decades ago, computers and related informational technologies were 

introduced into education as instructional tools. In the I 980's, personal computer 

technology began to be widely used in the classrooms (Clark, 2000). The U.S. Congress 

Office of Technology Assessment (OTA, 1995) estimated that the number of computers 

4 



5 

in K-12 schools increased by 300,000 to 400,000 a year in the decade of the 1980's. 

Despite this growth in computer usage, many investigations into computer use in 

classrooms have concluded that most teachers do not use instructional technologies. 

These investigations indicated that few teachers use computer-based technologies for 

instructional purposes (Hunt & Bohlin, 1995). Low level tasks such as drills and word 

processing were their major contribution of technology in the classroom and computers 

have not been integrated into most instructional curriculums (OT A, 1995). 

A 1996 report by the National Commission on Teaching and American's Future 

indicated that teachers needed to continually learn new technologies to keep up with the 

sweeping economic changes in today's world. American citizens wanted the U.S. to be 

on top and they viewed technological achievement as the vehicle to keep their country 

there. According to the National Center for Education Statistics (NCES, 1999) survey, 

one out of five current public school teachers said they felt prepared to handle today's 

technology. The other four teachers felt they had inadequate or superficial training and 

often had little support when the technology broke down. Perkins (1992) contended that 

"Today, Americans expected teachers to use the newest technology in their 
classrooms. Teachers were not being adequately prepared for the challenges of the 
next century therefore, students were learning and teachers were teaching in much 
the same way they did twenty (20) and even fifty (50) years·ago." (p. 479). 

Rivero (1999) stated that schools may have had the best computers, the most 

sophisticated curriculum software, and the fastest Internet but if that teacher doesn't 

know how to use any of it, it's not going to improve education. Although Day and other 

experts agreed that training teachers to use technology was essential to success in the 

classrooms, many teachers were not getting the training they needed. Teachers really 
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need the opportunity to play with technologies or get formal training, however, right now 

even good teachers were falling behind their students in terms of using technology 

(Day, 1996). 

Clark (2000) stated that there's a tremendous need for teacher training, and 

teachers want it desperately. He emphasized: 

"Many educators felt somewhat neglected and indicated that technology has been 
like a train leaving the station, they are running after it desperately trying to get on 
board. It is crucial for teachers to have appropriate training if they are to meet 
their students' needs for the twenty-first century." (p. 178). 

The problems schools face today in preparing students lies in limited and inadequate 

staff development, the time to provide training and the ability to learn on behalf of the 

teachers (Jones, 2001). By focusing on training as the key strategy, districts can make 

the transition from just using computers to building a true technology-rich learning 

environment. Professional development opportunities must be implemented to provide 

lifelong learning for teachers, who in tum must prepare a new generation of students for 

their technological future (Poole & Morgan, 1998). 

Need for Staff Development 

Technology has been in the school for a decade and a half now, but it took several 

years for the initial infatuation with RAM and ROM to wear off and a realization to hit 

that teachers had to be trained to use it (Siegel, 1995). Siegel added that only then can 

the innovation become a part of their teaching repertoire and not just a reward for 

students when they finish their work. Siegel (2000) emphasized, 

"Staff development is the key to successful technology implementation. Training 
was equally important to the actual equipment. You can have $200,000 worth the 



( equipment, but if teachers are not aware of the capabilities, it'll just sit there and 
they won't use it" (p.48). 
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Computer technology has not reached its potential in schools (Senese, 1984; Hannifin, 

Dalton, & Hooper, 1987) largely because many of America's teachers have been 

reluctant to make the move from traditional teaching methods to teaching with 

computers. Cuban ( 1986) insisted that in the past, the failure of new technologies in 

education has been blamed on the teacher's inability to adapt to the new technology to his 

or her learning style (Clark, 2000). 

According to Riley (I 998), schools needed to focus on giving teachers support and 

training to use technology. Riley added that current teachers needed the skills to lead this 

information revolution. Ten percent of teachers were proficient users of technology, 

reported Riley (I 995). Many educators today felt that their technological skills were 

inadequate and outdated. 

The greatest challenge was motivating teachers who are uncomfortable with 

technology, reported Principal Frankie St. James at Key Largo School in Florida (Milone, 

1999). He emphasized, "Many studies have investigated teachers' attitude toward the use 

of technology and their anxiety about using it. These studies were particularly important 

because teachers' attitude about computers and related technologies can positively or 

negatively influenced students' attitudes toward technology" (p.54). 

Khine (2001) asserted it was important to note that user acceptance and attitudes 

toward computers are critical in their successful implementation. He defined attitude as a 

mental and neural state of readiness, organized through experience and influenced upon 

the individual's response to a situation. A study of elementary teachers in a Cincinnati 
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teachers college indicated that the more computer experiences a teacher had the greater 

the indicator that the teacher felt comfortable and had a positive attitude toward 

technology (Akbaba & Kurubacak, 1998). 

Clark (2000) stated that the growth of technology as an instructional tool depended on 

teachers' attitudes about those technologies and their ability to use them for instruction 

and administrative purposes. Training programs must not only be designed for teachers 

to improve their skills with technology but also help teachers change their attitudes 

toward the use of instructional technology (Akbaba & Kurubacak, 1998). The OTA 

(1998) reported that teachers would readily adapt to the idea of using computers in 

schools if principals and school administrators provided the right learning and training 

environment. They added "teachers' attitudes toward technology do influence their use 

of technology therefore, educational leaders will not be able to help teachers provide 

meaningful instruction using technology unless they understand the teachers' attitudes 

towards computer and related technologies as educational tools" (Clark, 2000, p. 178). 

Tally and Grimaldi (1995) commented that many teachers seem resistant to integrating 

something new like technology; staff development programs need to take into 

consideration the slow process of teacher change. A study by the Apple Classrooms of 

Tomorrow reported that: 

"Teachers felt there was rarely anyone available to help them sort out what they are 
learning or to help them rethink and modify their initial practices and training 
rarely provided ongoing, multi-year support necessary for deep integration to 
occur. Support needs to be practical and pedagogical with proper training, what 
might be a grueling experience for those with inadequate computer skills can 
become a source of pride and self-confidence" (Tally & Grimaldi, 1995, p. 14). 
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Within the next ten years, over two million new teachers will be needed to replace 

retiring teachers and to meet increased student enrollment. Those new teachers must be 

skilled in using technology (Rosenthal, 1999). Most schools of education do not 

adequately train teachers to use and integrate technology in their classrooms. The 

National Council for the Accreditation of Teacher Education standards (NCATE, 1999) 

left teaching candidates to figure how to integrate technology into their classroom to the 

teachers. The standards in the year 2000 however required that technology must be 

integrated throughout the course work of new teachers (Rosenthal, 1999). 

It became crucial for teachers to have appropriate technology training during their pre-

service education if they expect to meet their students' needs in the 21st century. A large 

body ofliterature supported the idea that the biggest obstacle to teachers using 

technology in their classroom was the lack of adequate teacher training (Beaver, 1992; 

Brooks & Kapps, 1999; Ingram, 1992; Vagle & College, 1995; Yughi, 1997; Yildirim & 

Kriaz, 1999). A study on recent graduates by the OTA (1995) found that: 

"Less than ten percent of teachers felt prepared to use multimedia and presentation 
packages, electronic network collaboration capabilities, or problem-solving 
application and about half were ready to use drill-and-practice software, tutorial, 
games word processing software and publishing applications" (Rosenthal, 1999, 
p. 22). 

Rosenthal (I 999) noted that as governrnent investments in school technology 

increased, schools of education were pushed to arm new teachers with the knowledge and 

skills to use it. To what degree were institutions of higher education preparing 

tomorrow's classroom teachers to use technology? According to Arthur Wise, president 

of the (NCATE), most schools of education did not adequately train teachers to use and 
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integrate teclmology into their teaching. According to Jeanne Hayes, president of Quality 

Education Data, 

"Seldom are students asked to proactive teaching with teclmological tools; most go 
out into the field with a limited view of the ways teclmology can be used in the 
classroom. More over, while thirty-eight (38) states have teclmology requirements 
for teacher preparation programs, only two states, Vermont and North Carolina, 
require actual evidence of proficiency in the use of teclmology in teaching" 
(Rosenthal, 1999, p. 22). 

Accordingly to Cheryl Williams, director of Education Teclmology Program at the 

National School Boards Association, there were several reasons why colleges of 

education have not integrated teclmology into their courses. 

"First, many teachers education programs lack the hardware and software 
necessary to incorporate teclmology into the teaching agenda. Second, the 
education facilities have not provided the training they need to use teclmology 
effectively. Third, a majority of teachers education departments have not been able 
to invest in the teclmical support required to maintain a high-quality teclmology 
program. Finally, some higher education faculties have little understanding of the 
changes teclmology has brought to the K-12 classrooms, and therefore have not 
adjusted their own teaching methodologies to reflect these changes" (Rosenthal, 
1999, p. 22). 

The NCATE has taken steps to increase the probability that most new teachers will 

leave college able to integrate teclmology into their teaching. According to Williams, 

NCATE's Performance Based Accreditation Standards for the year 2000 will emphasize 

teclmology. Accredited institutions would be expected to have faculty who can integrate 

teclmology into their own instruction, and prepare teachers to use teclmology in the 

classroom. For a college to maintain accreditation, teclmology would have to be 

integrated throughout the coursework beginning in the year 2000 (Rosenthal, 1999). 

Schools of education could no longer ignore the speed at which the world has changed 

as more powerful computers and information networks became widely and affordably 
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available. With the help ofNCATE, the Association of Colleges for Teacher Education, 

and federal programs such as Preparing Tomorrow's Teachers to Use Technology, an 

increasing number of new teachers would graduate from college able to use technology 

effectively, with students reaping the educational benefits (Rosenthal, 1999). 

As our national action plan for technology became clear, technology was too 

important to the future of American education to let teachers go without the training they 

needed. Federal leadership combined with the involvement of higher education, states, 

and school districts could ensure that all of our nation's teachers were prepared to guide 

their students toward vast new worlds of learning through the information superhighway 

(Riley, 1995). 

It was fitting that the teachers of tomorrow were provided with the correct modeling 

of technology in their first education classes. The sooner college students were exposed 

to the latest forms of technology the more equipped they would be to integrate these tools 

into their teaching strategies for the benefit of future learners (Davison, Burr, Eberlein, 

Fuchs, Sauchdo, & Steffen, 2000). 

As we approach the millennium, professional development opportunities must be 

implemented to provide lifelong learning for teachers, who in turn must prepare a new 

generation of students for their technological future (Poole & Morgan, 1998). 

Staff Development 

Richardson (1998) stated that the object of training was to help staff become more 

efficient and effective in operating computers. According to Jones (2001) training, 

preparation and work environment played key roles in teachers' readiness to use 



technology. He added that 

"Teachers must be competent users of technology before they can creatively and 
effectively apply it. Every teacher needs readily available resources on 
information technology and extensive professional development in utilization of 
these resources. Staff development will require a significant long-term 
commitment oftime and resources" (p. 7). 

Benson ( 1997) emphasized that: 
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"For any technology implementation plan to be successful, it must allocate 
sufficient time and resources for a focused staff development program. Many 
schools are discovering that traditional models of staff development particularly a 
one-time in-service training for the entire faculty are ineffective for teaching 
computer use and for helping teachers develop methods to use computers as 
instructional tools. Innovative staff development programs are needed to meet 
teachers' diverse and ever-changing technology need" (p. 17). 

Reiss (1998) included that time was required to create a computer-competent teacher. 

Fischer, Eisenhauer, Schmaarsmith, and Smith (1998) added that to become computer 

literate a teacher must receive proper training. It takes 2-5 years for a person to move 

from entry-level technology usage to the proficient and exemplary levels of fully 

integrating technology in the curriculum (Anderson, 2000). This long term plan would 

allow for teachers to absorb information, try ideas out in the classrooms and then come 

back for more discussion (Day, 1996). John Durbin, principal at Agua Fria Union High 

School in Phoenix, Arizona expressed that 

"Anytime you're trying to make a innovation you're hoping to be moderately 
successful, you have to spend time on staff development. In my experience any 
change that failed was because sufficient energy and time was not put into staff 
training." (Siegel, 1995, p. 44). 

Tally and Griumaldi (1995) indicated that the key components of a staff development 

plan would include practical and pedagogical support. They added that 

"Practical support included the nuts and bolts training that workshops provided and 
ongoing trouble-shooting in the school building. Pedagogical support helped 



teachers frame curriculum goals, select appropriate software and materials, and 
evaluating what happens in the classrooms technology-based curricula are 
implemented" (p. 15). 
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The NCREL (2000) believed five components were needed in teacher development in 

technology: 1) building a knowledge base, where teachers acquire new knowledge 

and information and built a conceptual understanding of hardware and software; 

2) observing models and examples, here teachers studied instructional examples in 

order to develop a practical understanding of the research; 3) reflecting on practice, the 

learners analyzed their instructional practice on the basis of new technology knowledge; 

4) changing one's practice, the new knowledge was translated into plans and actions for 

instructional change; 5) and gaining and sharing expertise, where teachers continued to 

refine their wisdom with their peers. 

According to researchers, the plan must provide twenty (20) to sixty (60) in-service 

hours in technology for every staff member (Anderson, 2000; Day, 1996; Milone, 1999). 

Effective training must be specific to the hardware and software the teacher would be 

using according to Sharon McCoy Bell, director of educational technology, New Orleans 

School District (Siegel, 1995). Professional development must be offered in a variety of 

forms such as on-site, just-in-time training for specific projects or piece of hardware 

(Milone, 1999). "If teachers are going to use technology as an important element in how 

they teach, they need to spend time working with it, as well as time talking with other 

teachers on how to best integrate it" ( Siegel, 1995, p. 45). 

Siegel (1995) recommended that the key to real learning and integration of technology 

was the ongoing conversation among teachers and trainers. According to Anderson 

(2000), learning from other staff members was the best way for many teachers to learn. 

Several researchers insisted that establishing a collaborative teaching atmosphere by 
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using the teacher to teacher training model (Feldman, Coulter & Konold, 2000; Hope, 

1996; Poole & Morgan, 1998; Riley, 1995; Tally & Grimaldi, 1995) teachers shared 

information with each other through formal on-site seminars and informal get-togethers 

These authors stressed that this collaborative work had a positive impact on teachers 

acceptance of computers. Camaraderie, enthusiasm and support were all benefits of such 

collaboration (Sandholtz & Rigstaff, 1993). Milone (1999) stated that teachers thereby 

acquire skills in a non-threatening environment and they become a motivating force for 

other teachers. He added that doors began to open when teachers collaborated and an 

incredible learning community emerged with teachers supporting each other. 

Budget for Training 

The NCES pointed out that over the past decades, federal, state, and local 

governments have invested billions of dollars to outfit schools with computers and 

telecommunications technologies with high expectations for improved student 

preparation and performance. Today, over 1.6 million computers sit in American schools 

and billions of dollars were spent to connect computers to the Internet. Despite their 

investment, a recent survey (NCES, 1999) found that only twenty (20) percent of the 2.5 

million teachers who currently work in our public schools feel comfortable using 

technology in their classrooms (Rosenthal, 1999). 

The first thing to understand was that technology was not a cost but an investment. 

Riley (1995) noted that educators mentally needed to invest in a firm, fair, and flexible 

staff development. He added, schools should firmly commit themselves to technology as 

the wave of the future. Our nation needed to do a much better job of developing 

teachers' professional skills by training them to use new technology effectively. In one 
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sense, the nation owed its teachers nothing Jess. Lynn Silver, national strategic relations 

manager for Apple Computers quoted, "Ifwe don't invest in providing technological 

skills for our current and future teachers, we are creating a digital divide that could have 

vast social consequences for students" (Riley, 1995, pg. 51). 

Failure to include training in a technology fund could lead to poor staff morale and 

negate anticipated gains in productivity (Richardson, 1998). He added: 

"Have you ever considered the amount of investment your funds have make in 
software or hardware that is underutilized by your staff? Many funds are 
willing to bear the cost of cutting-edge technology in hardware and software but 
cut back when an investment in staff training is required. Your objectives in 
putting good tools in the hands of your staff will be shortchanged if you fail to 
commit to an adequate training program. Your commitment to good training 
should be the same for replacement of fund office computer hardware or 
software, or implementing an automated-attendant telephone system with voice 
mail, or incorporating an interactive voice response system for your 
participants" (p. 7). 

Staff development needed to move out of the horse and buggy era. The nation's 

teachers cannot become coaches if they were only offer, on the average, technology 

training once per semester to approximately sixty (60) percent of them. A recent 

national study indicated that more than twenty-five (25) percent of schools spend nothing 

on staff development. On an average, districts devoted no more than fifteen (15) percent 

of technology budget to teacher training. Experts said it should be closer to twenty-five 

(25) to thirty (30) percent (Garvin, 2000). 

Millions of dollars have been spent on hardware and software, billions on new and 

retrofit buildings, but very little on refitting teachers (Day, 1996). According to 

Kalmbacher and Maxson (2000), teacher development programs must have the funds to 

ensure the effective use of the computers. The U.S. Department of Education 
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recommended schools to devote at least thirty (30) percent of their technology budget to 

teacher training. CEO Forum's Two-Year report, Professional Development: A Link to 

Better Leaming, revealed: 

"The nationwide call for improved teacher training. Educators needed much more 
than intermittent sessions on how to operate equipment and software. Teachers 
needed and deserved ongoing exposure to technology so it could become a 
seamless component of instruction that would lead to real results for students" 
(CEO Forum, 1999, p. 2) 

Access to Technology 

In order to achieve ownership of technology as a tool for the real work, teachers must 

have equipment available to them at night, on the weekends, and in their classrooms 

(Tally et al., 1999). Access to the technology was essential for them to become users 

(Sheingold & Hadley, 1990). Roger Coffee, principal at Webster Elementary stated: 

"If they don't have the equipment to use at home, the training is not going to take. 
Teachers should be able to check out computers overnight and during the summer. 
They must have the tools at home to become experts. It is frustrating to teachers to 
be expected to accomplish tasks using computer technology but not to have access 
to components of the configurations" (Siegel, 1995 p.45) 

The extent to which teachers were given time and access to pertinent training to use 

computers to support learning played a major role in determining whether or not 

technology had a positive impact on achievement. The NCREL emphasized the success 

or failure of technology involved teachers seeing it as a valuable resource. The success 

depended on having significant critical access to hardware and applications that were 

appropriate to the learning expectations of the activity (NCREL, 2000). 
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In many schools the most common reasons given for the low level of computer usage 

were schools had limited access to equipment and a lack of training (Bosch & 

Cardidnale, 1993). Topp, Mortensen, and Grandgenett (1995) identified several obstacles 

that infused technology into education programs at schools. They included limited 

availability of equipment, lack of training, and lack of funds. 

For teachers to make informed choices on the uses of technology, they must be literate 

and comfortable with the range of educational technologies. Day (1996) indicted that 

after a training session, some schools gave every teacher a computer, allowed time for the 

teachers to develop personal confidence, expertise and provided the teachers with the 

same technology they were trained on. 

Summary of Information Obtained from Selected Sources 

The writer, Suzanne S. Keil, contacted sixteen (16) selected institutions from across 

the United States and invited them to submit descriptive information of their current staff 

development in technology. Specifically information related to the following issues were 

solicited: 

I. Staff Development Training 

2. Support System in Technology 

Institutions contacted included: 

Agua Fria Union High 
Phoenix, Ariz. 

Bellevue School District 
Bellevue, WA 

Auburn School District 
Auburn, WA 

Bellingham School District 
Bellingham, WA 



Federal Way School District 
Federal Way, WA 

Greater Latrobe Jr. High School 
Latrobe, PA 

Lake Washington School District 
Redmond, WA 

Needham Broughton High School 
Wake County, NC 

Foshay Leaming Center 
Los Angeles, CA 

Kent School District 
Kent, WA 

Lynbwok School District 
Long Island, NY 

New Orleans School District 
New Orleans, LA 
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Sandburg Middle School 
Fairfax County, VA 

Superintendent of Public Instruction 
Olympia, WA 

Tahoma School District 
Tahoma, WA 

West Valley City School 
Spokane, WA 

An analysis, of the information obtained from the sources, revealed that five (5) 

characteristics were generally common in staff development in technology. They 

included: 

1. Ongoing Training: Each school district provided in-service training throughout 

the school year for new and returning teachers. Introduction to computers, 

e-mail and Internet were the three courses that all the schools instituted. 

2. Time: Each school had flexible schedules and creative ways to provide time 

for the teachers to take classes, practice skills and collaborate with other 

teachers and technology coordinators. Nine (9) school districts provided 

20-60 in-service hours each year for new and returning teachers. 

3. Collaboration: A strong component of all the programs was a commitment to 

collaboration among colleagues. All programs had two (2) strategies for 

collaboration: 

a. Peer Coaching: teachers worked together to enrich the curriculum and 



19 

pedagogy within subjects by attending one another's classes, discussed 

what went on and helped one another solve problems. 

b. Study Groups: small groups consisting of teachers and administrators 

met regularly to exchange ideas, plan lessons, and evaluate teaching 

practices. 

4. Strong Support System: Each school district had at least one full-time 

technology coordinator. This person provided that added support and guidance 

teachers and administrators needed for technology 

5. Access: Each school provided a computer workstation for its teachers. This 

allowed for practice time. Six school districts allotted a personal computer in 

the classroom for each teacher and a laptop for home usage. 

Summary 

The research literature and information summarized in chapter 2 supported the 

following themes: 

1. Teachers acceptance and attitudes toward computers are critical in successful 

implementation of educational technology. 

2. Five components are crucial to the competency of teachers in technology: building 

a knowledge base in technology, access to computers, budget, time, and 

collaboration. 

3. Model staff development in technology programs, cited in the review ofliterature, 

revealed that the following characteristics were common to staff development in 



technology: ongoing training, time, collaboration, strong support system, and 

access to technology. 
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CHAPTER THREE 

PROCEDURES OF THE PROJECT 

The purpose of the project was to develop a model staff development program in 

technology skills training for secondary level teachers. To accomplish this purpose, a 

review ofrelated literature and research was conducted. Additionally, related 

information from selected sources were obtained and analyzed. 

Chapter 3 contains background information describing: 

I . Need for the Project 

2. Development of Support for the Project 

3. Procedures of the Project 

4. Planned Implementation and Assessment of the Project 

Need for the Project 

The need for the project was influence by the following considerations: 

1. The writer, Suzanne S. Keil, a certified teacher who had served for nineteen 

years as a private school teacher, was assigned to a team to develop a 

technology program for a newly formed private school district during the 

1999-2000 school year. 

2. Through participation as a committee member in the district strategic planning 

of a technology program, the committee stated that there was a need for a staff 

development program. 

3. Information researched from Washington's public and private schools along 
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with other national public schools further made the writer aware of the need 

for a staff development program in technology. 

4. Undertaking the study coincided with the writer's graduate studies in 

educational administration at Central Washington University. 

Development of Support for the Project 
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Since 1998, the writer served as a secondary teacher in the Cascade Christian School 

District in Puyallup, Washington. During the 1999-2000 school year, the Superintendent 

invited the author to be part of a strategic committee to develop a technology program for 

the district. 

The program was expected to provide a comprehensive, unified, and approved plan 

for teachers and students to become more efficient and effective in operating computers. 

In the absence of a staff development program for teacher efficiencies, the writer was 

asked to develop a model program for teacher training. The writer consulted with 

Washington's public and private schools along with other national school districts to 

adopt and develop a training program for teachers. 

Given the support of the Cascade Christian School District, the resources above and 

the desire of the writer to provide teacher training with quality instruction, the decision 

was made to develop the model of teacher training in computer literacy. 



23 

Procedures for the Project 

The writer undertook the following procedures to develop a model staff development 

in technology for selected secondary schools: 

I. An extensive investigation of related research and literature was undertaken, 

organized and analyzed. 

2. Additionally, unit overviews, learning objectives, performance criteria, 

learning activities, and evaluations were adapted and developed. 

3. Information regarding staff development appropriate for use in either private 

or public school districts were obtained from: 

Auburn School District 
Auburn, WA 

Bellevue School District 
Bellevue, WA 

Charles Wright Academy 
University Place, WA 

Federal Way School District 
Federal Way, WA 

Kent School District 
Kent, WA 

Lynbrook District 
Long Island, NY 

Lake Washington School District 
Redmond, WA 

New Orleans School District 
New Orleans, LA 

Puyallup School District 
Puyallup, WA 

Seattle Christian School 
Sea-Tac, WA 

Sandburg Middle School 
Fairfax Country, VA 

West Valley City School 
Spokane, WA 
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Planned Implementation of the Project 

The model staff development program in technology skills training for secondary 

teachers was developed as a result of this project, will be presented by the writer for 

review by the Cascade Christian School District's technology committee during the 

2001-2002 school year. The project presented on the following pages in Chapter four 

will be adopted by the school district as the designated curriculum for staff training in 

technology at Cascade Christian Jr./Sr. High School and will be subject to annual 

review by the technology committee. 

Implementation of the model program has been tentatively scheduled for the fall of 

2002. Following the implementation of the model program, assessment will be 

on-going and data obtained annual will be used to modify the model program at the 

discretion of the administration, technology committee, and faculty. 



CHAPTER4 

THE PROJECT 

The model staff development program in technology skills training for secondary 

level, which was the subject of this project, has been presented in Chapter Four, in seven 

(7) units including: 

Unit One - Introduction 

Unit Two - Basic Computer Skills 

Unit Three - Internet Skills 

Unit Four - Microsoft Word Skills 

Unit Five - E-mail Skills 

Unit Six - Easy Grade Pro Skills 

Unit Seven - Assessment 

25 



( 

A Model Staff Development 

Program in Technology Skills 

Training for Secondary Level 

Suzanne Keil 



TABLE OF CONTENTS 

1. Unit One: Introduction ............................................................ P 1 

2. Unit Two: Basic Computer Skills ............................................... P3 

3. Unit Three: Internet ............................................................... P7 

4. Unit Four: Microsoft Word ..................................................... Pl2 

5. Unit Five: E-mail.. .............................................................. Pl9 

6. Unit Six: Easy Grade Pro ....................................................... P23 

7. Unit Seven: Assessment ........................................................ P28 



UNIT ONE 



UNIT ONE 

Introduction 

The project of a model staff development in technology skills training is based on the 

increasing demand for advanced technology applied in education. Staff members must be 

competent users of technology before they can apply it to their school. The goals and 

perspectives of the project focus on the skills needed to be a successful staff member and 

practices that can be continued at home. 

Staff training on the use of technology as a tool for instruction and productivity is 

necessary for successful integration of technology into the curriculum. Technology 

training sessions must require a significant long-term commitment of time and resources 

on the part of the school district. This long-term plan will allow for teachers to absorb 

information, practice skills, and experience the use of technology. Twenty (20) hours 

will be offered by the school district with time off to take additional classes in 

technology. Additional time will be given for staff to practice, collaborate, and plan for 

technology use in the school. 

This project is designed for teachers at the secondary level. The goals and objectives 

for the program focus on having the participants experience how technology can serve as 

a catalyst in the change process. Inservices and activities will motivate educators to 

become proficient in five (5) areas: basic computer skills, Internet, Microsoft Word, 

E-mail, and the Easy Grade Program. Additional learning activities in this manual will 

provide the practice that staff members need to master key skills in technology. 
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Philosophy: 

Technology learning must support staff in a fast, flexible and friendly way. The 

following set of guidelines helps to meet the ever-changing demands on technology. 

1. Strive toward the ultimate goal of helping all staff to become independent users of 

technology. 

2. Manage technology as a tool to be infused into the curriculum to enhance student 

literacy. 

3. Design a sequenced training to take staff from basic technology skills to advance 

technologies depending upon ability and experience. 

4. Allow for a three (3) year implementation of staff development in order for staff to 

become comfortable with hardware and software. 

5. Regularly assess the effectiveness of the staff development program. 

Training Models: 

This program will consist of twenty (20) hours of inservices for each school year. 

Teachers are encouraged to take other classes and will be given the day off with pay for 

any technology classes they take. After school classes will be offered along with summer 

sessions. Substitutes will be used each Wednesday for a particular subject area for staff 

members to reflect on practice, peer coaching or working with an expert in developing a 

key technology skill. 
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UNIT TWO 

Unit Overview 

In this section staff members will learn to operate the computer and its components by 

using the basic skills needed for hardware and software programs such as turning the 

computer on to copy and paste information. Training time will be a three (3) hour 

session. 

Goals: The staff operates the computer and its components. 

• Identify main hardware components and demonstrate responsibility in 

equipment use and care. 

• Save and print to multiple locations. 

• Use menus to navigate a network. 

• Use computer organization skills. 

• Read, interpret and follow directions or documentation concerning the care 

and operation of software and hardware. 

Compnter Basic Skills: 

I . Turn computer on and off. 

2. Open, move, copy, rename and delete a file. 

3. Create, move, copy, rename and delete a folder. 

4. Turn on/offFoolProof security. 

5. Open, close and size a window. 

6. Start an application. 
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7. Use more than one application at a time. 

8. Save a document to a server, floppy and hard drive. 

9. Cut, copy and paste information. 

I 0. Customize display properties. 

I I. Change mouse speed, speaker volume and screen brightness. 

12. Add a shared network printer. 

Timeline: 

1. Staff will be given a 3 hour inservice to be introduced to this program and to 

experiment with the many applications of this software. 

2. Activities will be sent home with the staff member to practice and will summit a 

print out copy of each activity to the administrator. 

Activities: 

The following activities will be provided for staff members to practice their skills at 

home, school, or the classroom. These activities were taken from the Lake Washington, 

Tahoma, and Auburn school districts staff development for technology and modify for 

beginning teachers in technology. 
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Activity 1- Microsoft Windows 98: 

This activity will help you learn portions of Microsoft Windows 98. Below is a list of 
skills that are covered in this activity. 

Microsoft Windows 98 Skills: 

1. Turn computer on and off 
2. Use Windows 98 help 
3. Start an application 
4. Cut, copy and paste information 
5. Open, move, copy, rename and delete a file 
6. Save a file to the A: drive and the C: drive 

Directions: 

1. Turn on the computer, log in, and perform the following tasks. 
2. Type each of the following queries in Help under the Start button. Use the index 

tab in help. 

• Print screen key 
• Cutting and pasting 
• Renaming a file 
• Saving a file to a floppy disk 
• Creating folders 

3. Choose one of the items above and use Print Screen to show what help described. 
4. Open Microsoft Word. 
5. Paste the print screen from the Clipboard into Word by choosing Paste form the 

Edit menu. 
6. Save the Word document to a folder on your C: drive and name the document 

"computer works." 
7. Navigate to the folder on your C: drive where you save the "computer works" 

document. 
8. Use Print Screen to create an image that shows the document in that folder. 
9. Open the "Computer Works" document again. 
10. Past the print screen into word by choosing Paste form the Edit menu.11. 
11. Save the "Computer Works" document again. 
12. Insert a floppy disk into your floppy disk drive. 

Locate the "Computer Works" document on the C: drive. Don't open it, rather 
right click on it and choose Sent To> 3-1/2 floppy (A) form the list of options 
that appear. This will copy the file to your floppy disk. 
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Activity 2- Microsoft Windows 98: 

This activity will help you learn portions of Microsoft Windows 98. Below is a 
list of skills that are covered in this activity. 

Microsoft Windows 98 Skills: 

1. Turn computer on and off 
2. Start an application 
3. Create, move, copy rename and delete a folder 
4. Save a tile to the A: drive and C: drive 
5. Open, close, minimize maximize, restore and size a window 
6. Use more than one application at a time 
7. Customize display properties 
8. Change mouse speed, speaker volume and screen brightness 

Directions: 

1. Turn on the computer, log in and perform the following tasks. 
2. Choose and apply a new Wallpaper background on your computer desktop. You 

will need to go through the Display Control Panel. 
3. Mute the Volume (this is done by right or left clicking on the yellow speaker on 

the Taskbar or by using the volume buttons on the side of your computer). 
4. Add a Network Printer (this is done through the Printers Control Panel. It is 

found with the other Controls Panels, and also under the Start Menu > Settings or 
under My Computer on the desktop of your computer. 

5. Open more than one application then minimize all of them to the taskbar. You 
can minimize the applications by clicking the button in the top left comer of the 
application window that looks like a single dash. 

6. Create a new folder on the desktop. Name it "Cougars." Right click on your 
computer desktop and choose New Folder from the list of options that appear. 
You can either immediately type the new name, or if you want to do this later you 
can right click on the folder and choose rename from the list of options that 
appear. 
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UNIT THREE 

Overview 

In this section staff members will access current information to supplement resources 

with electronic sources and on-line services. The staff will learn to use search engines 

and how to copy information from the Internet. Training time will consist of five (5) 

hours. 

Goal: The staff will use a variety of technology tools to communicate effectively. 

• Create, publish and communicate ideas using multimedia tools. 

• Use the Internet to locate information. 

Internet Skills: 

I. Use Foo!Prooflogin to access Netscape. 

2. Go to a specific URL. 

3. Navigate within a Website. 

4. Use search engine techniques to find information. 

5. Use bookmarks to revisit common web sites. 

6. Copy information from a Web page and paste to a word processing document. 

7. Save and print selected content from a web page. 

8. Submit data to web page. 

9. Reading and printing PDF files. 

10. Customize toolbars. 

11. View and clear history. 

12. Delete temporary Internet files. 
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Timeline: 

1. Staff will be allowed five (5) hours ofinservice to be introduced to this program 

and to experiment with the Internet. 

2. Activities will be sent home with the staff member to practice and will summit a 

print out copy of each activity to the administrator. 

Activities: 

The following activities will be provided for staff members to practice their skills at 

home, school, or the classroom. These activities were taken from the Lake Washington, 

Tahoma, and Auburn School Districts staff development for technology and modified for 

beginning teachers in technology. 

PS 



Activity 1-Internet: 

This activity will help you learn portions of the Internet Explorer 5.0. Below is a list 
of skills that are covered in this activity 

Internet Explorer 5.0 skills: 

1. Go to a specified page on the World Wide Web 
2. Navigate within a web site 
3. Add and organize favorites 
4. Use a search engine to find a Web page 
5. Copy information from a Web page and paste into a word document 
6. Customize toolbars 
7. Set a new home page location 

Directions: 

1. Go to CNN News (www.cnn.com) by typing the address into the box on the 
Address bar at the top of the web browser window. What is today's headline at 
CNN News? 

2. Click on the headline to go to the full story. 
3. Copy the headline by holding down 

the left mouse button and dragging your mouse over the headline. Then let go of 
the mouse button. Next choose Copy form the edit menu. Paste the headline into 
Word by choosing Paste from the Edit menu. 

4. Use a search engine to find a picture of your favorite type of animal. Right click 
on the picture and choose Copy from the list of options that appear. Paste the 
picture to your Microsoft Word document by choosing paste from the Edit menu. 
Copy and paste the web address of this web page below your picture. 

5. Go to the Favorites menu and choose add a favorite and add this web address to it. 
6. Find a section of text from this web site that you can use in your job, copy the text 

and then paste it to your Microsoft Word Document. 
7. Set your home page to a web site that you will visit everyday. Go to the Tools 

menu and choose Internet Options. Either type in the web address you want for 
your homepage into the Home page box or click the Use Current button to use the 
web address that is currently loaded in the browser window. Click OK. 

8. Copy and paste the web address of your new home page to your Microsoft Word 
document. Create a Print screen shot showing the Internet Explore Window. 

9. Customize your toolbars. Go to the View menu and toolbars. Make sure you have 
a check mark in front of Standard Buttons and Address Bar. Choose Customize 
under the View menu and Toolbars. Under the Text Options drop down menu at 
the bottom of the window click the down arrows. Choose No text labels. Click 
the Close button. 

10. Move your Address Bar to another location. You do this by left clicking on the far 
left side of the toolbar when your mouse pointer appears as a double-ended 
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arrow. Without letting go of the mouse button drag the toolbar to another 
location. The toolbars will only switch with other toolbars at the top of the 
window. 

11. Create a Print Screen shot showing the changes you made to your Internet 
Explorer Window. 

12. Print your Word document. 
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Activity 2-Internet Explorer 5.0 

This activity will help you learn portions of Internet Explorer 5.0. Below is a list of 
skills that are covered in this activity. 

Internet Explorer 5.0 skills: 

1. Go to a specified page on the World Wide Web 
2. Navigate within a web site 
3. Add and organize favorites 
4. Use a search engine to find a Web page 
5. Copy information from a Web page and paste into a word document 
6. View and clear History 

Directions: 

1. Use the Google search engine. Search for information on a place you would like to 
visit. Choose a web site from your list of search results. Add two of theses sites 
to your Favorites by going to the Favorites menu and choosing add to Favorites. 
Copy the web address of your web site to the Word document by choosing Paste 
from the Edit menu. 

2. Visit the Washington State Department of Transportation (www.wsdot.wa.gov). 
Add this site to your Favorites. 

3. Go to the Favorites menu and choose Organize Favorites. 
4. Create a new folder. Name the folder with your first name. 
5. Move the three favorites you added to this folder. You can either use the Move 

button or drag and drop the items. 
6. Open the new folder you created in the Organize Favorites window. 
7. Create a print screen shot showing the Favorites window. 
8. Print your word document. 
9. View the History of the web sites you have visited by clicking on the history 

button on the tool bar. Create a print screen of the Internet Explorer Window 
showing the History folder open. 

10. Use History to locate the Washington State department of Transportation. Click 
on it to return to that web site. 
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UNIT FOUR 

Overview 

The staff member will use technology to maximize productively and effectiveness. 

The staff will learn how to use Microsoft Word from producing lesson plans, calendars, 

newsletter and word processing skills. Training time will consist of five (5) hours. 

Goal: The staff will use technology to maximize productivity and effectiveness. 

• Develop keyboarding skills. 

• Produce documents using a word processor. 

• Use a database to obtain and maintain records. 

• Use a spreadsheet to create a chart. 

Microsoft Word Skills: 

1. Create a new document. 

2. Save a document to a specified location. 

3. Open a saved document from a specified location. 

4. Open and use a template. 

5. Use the Office Assistant/Microsoft Help 

6. Cut, copy and paste information. 

7. Format font, paragraph and text style. 

8. Customize page setup. 

9. Format tabs. 

10. Insert, format and customize tables. 

11. Insert and format pictures from a variety of sources. 
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12. Create bulleted and numbered lists. 

13. Create columns. 

14. Use the spelling and grammar check. 

15. Create headers and footers. 

16. Preview and print a document. 

17. Bold, italicize and underline. 

18. Thesaurus. 

19. Undo/redo. 

20. Print 

21. Change layouts. 

22. Save and rename files. 

Time line: 

!. Staff will be allowed five (5) hours ofinservice to be introduced to this program 

and to experiment with the many applications of this software. 

2. Activities will be sent home with the teacher to practice and will summit to the 

administrator a print out copy of each activity. 

Activities: 

The following activities will be provided for staff members to practice their skills at 

home, school, or the classroom. These activities were taken from the Lake Washington, 

Tahoma, and Auburn school districts staff development for technology and modified for 

beginning teachers in technology. 
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( Activity 1- Microsoft Word 2000: 

This learning activity will help you learn portions of Microsoft Word 2000. Below is 
a list of skills that are covered in this activity. 

Microsoft Word 2000 skills: 

I. Create a New Document 
2. Save a document to a specified location 
3. Use the Office Assistant/Microsoft Help 
4. Format Font, paragraph and text style 
5. Customize Page Setup 
6. Insert, format and customize tables 
7. Insert and format pictures from a variety of sources 
8. Create Bulleted and numbered lists 
9. Create columns 
10. Use the Spell and grammar check 
11. Create Headers and Footers 
12. Preview and Print a document 

Directions: 

1. Create a title from the Format menu Format the Font bold, and Format the 
paragraph right justified. 

2. Inset a Picture from Clipart that is to the left of the title. If needed resize the 
picture by dragging a comer "handle" toward the center of the picture. The 
"handle" is a small square that will appear along the sides of the picture when it is 
selected. 

3. Format the Picture so it has a fill color and a line style. 
• From the View Menu, choose the toolbar >Picture so it floats on the 

window. 
• Use the text Wrapping button and choose None. 
• Move the picture next to the title 
• Use the Format Picture button the Picture Tool bar, choose the Colors and 

Lines tab to fill the picture. 
• Use the format Picture button on the Picture Toolbar, choose the Colors 

and lines tab to place a solid line around the picture. 
4. From the Drawing toolbar use Line to insert a line below the picture and title 
5. Under the line type your school name and date. 
6. From the Insert menu choose Break. Insert a continuous section break to apply a 

different format. 
7. From the Format menu choose columns. Create two columns with a vertical line 

between. 
8. In the first column add a title. Center the title and change the font size. 
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9. Below the title create a bulleted list of the articles in your newsletter. Bullets and 
Numbering is available under the Format menu. 

I 0. Write an article. 
11. Create an AutoShape, insert text and picture. 

• From the View Menu, choose Toolbar, Drawing. 
• Select Autoshapes from the menu of the Drawing Toolbar, choose and 

create an Autoshape of your choice. Resize it to fit by using the square 
handles on the selected Autoshape. 

• Query the Office Assistant how to add text to Autoshapes. 
• Add a text box and place it on top of the Autoshapes. 
• Insert a Picture of Clip Art and place it on the Autoshape. 
• Select the Autoshape, Text and picture by holding down the shift key and 

clicking on each item with the mouse. From the Draw menu on Drawing 
Toolbar, choose Group. All three items become one item now. 

12. Write more articles. 
13. Insert a table, format and insert text to table. 
14. Insert a line to divide two articles. 
15. Use Word Art to create a title, format and align above article. 
16. Insert articles, change the font style and size. 
17. Insert a picture from the Clip Art Gallery. 
18. Choose the Image Control button from the Picture Toolbar and format to 

grayscale. 
19. Have Newsletter fit a one-page document. 
20. Insert a footer with a quote of the month. 
21. Check Spelling and grammar. 
22. Check the appearance of the newsletter in the Print Preview. 
23. Print the Word document. 
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Activity 2- Microsoft Word 2000: 

This learning activity will help you learn portions of Microsoft Word 2000. Below is 
a list of skills that are covered in this activity. 

Microsoft Word 2000 skills: 

1. Create a New Document 
2. Save a document to a specified location 
3. Cut, copy and paste information 
4. Format tabs 
5. Customize Page Setup 
6. Insert, format and customize tables 
7. Create Bulleted and numbered lists 
8. Use the Spell and grammar check 
9. Create Headers and Footers 

10. Preview and Print a document 

Directions: 

1. Create a new Blank Document. 
2. Change the paper size to use Landscape Orientation by customizing the Page Set. 
3. Insert "Lesson Plan" in header, center, bold and italic. 
4. Format tabs: 

• Left tab at Yi" 
• Center tab at 4 Yi" 
• Right tab at 8 Yi'' 

5. Insert name, grade/subject and school name at tab stops. 
6. Insert a table with 6 columns, 14 rows. 
7. Insert text and format the size and font of each cell. 
8. Copy recurring information and paste into cells (i.e. lunch). 
9. Draw and erase the table to customize your schedule. 
10. Shade cells that represent when the students are not in the classroom. 
11. Change font size and styles to create a desirable look. 
12. Customize the entire table to fit one page. 
13. Check spelling and grammar. 
14. Check the appearance of the lesson plan in the print preview. 
15. Save the document to C: drive. 
16. Open document at a later date and enter different data. 
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Activity 3 - Microsoft Word 2000: 

This learning activity will help you learn portions of Microsoft Word 2000. Below is 
a list of skills that are covered in this activity. 

Microsoft Word 2000 skills: 

1. Create a New Document 
2. Save a document to a specified location 
3. Use the Office/Assistant Microsoft Help 
4. Cut, copy and paste information 
5. Format Font, paragraph and text style 
6. Customize Page Setup 
7. Insert and format pictures from a variety of sources 
8. Create Bulleted and numbered lists 
9. Use the Spell and grammar check 
10. Create Headers and Footers 
11. Preview and Print a document 

Directions: 

1. Insert your name and school in the header of the document and align it to the 
right. 

2. Customize Page Setup Margins to 1" on all margins. 
3. Insert a picture Clip Art from the Borders and Frames gallery. 
4. Create a three-line letterhead that is centered. Type the school name on the first 

line, Bold font Style. On lines two and three, type the address in a smaller font, 
regular font style. 

5. Change font style and align left to format the body ofletter. 
6. Type a friend! y letter. 
7. Query the Office Assistant to indent paragraphs. 
8. Include a bulleted list somewhere in the body of the letter. 
9. Indent the bulleted list (you can use either first line indents or the increase indent 

button on the toolbar.) 
10. Copy.the Picture from the top of the page and paste at the bottom of the page. 
11. Check spelling and grammar. 
12. Check the appearance of the letter in the Print Preview. 
13. Print the document. 
14. Customize the letter document to fit on one page. 
15. Save the document on the C: drive. 
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Activity 4 - Microsoft Word 2000: 

This activity will help you learn portions of Microsoft Word 2000. Below is a list of 
skills that are covered in this activity. 

Microsoft Word 2000 skills: 

I. Open a saved document from a specific location 
2. Open and use a template 
3. Cut, copy and paste information 
4. Insert and format pictures from a variety of sources 
5. Preview and Print a document 

Directions: 

I. Go to File menu and select New. 
2. Choose the teacher tools tab and open the Certificate template. 
3. Customize the school name and student name. 
4. Insert a date on the date line. 
5. Delete existing picture. 
6. Insert and format new Picture. 
7. Print preview certificate. 
8. Print certificate. 
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UNIT FIVE 

Overview 

The staff members will understand technology to communicate to other staff, 

administrators, students, parents and the community. The staff will learn how to send 

and receive their e-mail along with sending and opening attachments. Training time will 

consist of a two (2) hour inservice. 

Goal: The staff learns to communicate within the school and outside the school by 

electronic means. 

• Communicate with staff using electronic message. 

• Communicate with parents, students and community by electronic means. 

E-mail Skills: 

1. Log on to e-mail. 

2. Read messages. 

3. Reply to sender only. 

4. Reply to all recipients. 

5. Create, address and send messages. 

6. Forward messages. 

7. Manage e-mail messages: delete and save. 

8. Create and manage e-mail folders. 

9. Message attachments: send, receive and save. 

10. Change password. 
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11. Make a distribution list. 

12. Use a distribution list. 

Timeline: 

I. Staff will be given a two (2) hour inservice to be introduced to this 

program. 

2. Activities will be sent home with the staff to practice and will summit to the 

administrator a print out copy of each activity. 

Activities: 

The following activities will be provided for staff members to practice their skills at 

home, school, or the classroom. These activities were taken from the Lake Washington, 

Tahoma, and Auburn school districts staff development for technology and modified for 

beginning teachers in technology. 
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Activity 1 - Outlook 2000 (e-mail): 

This activity will help your learn portions of Outlook 2000 (e-mail). Below is a list 
of skills that are covered in this activity. 

Outlook 2000 (e-mail) Skills: 

1. Create, send, reply, forward and recall messages 
2. Insert, send, open and save attached items 
3. Save and delete a message 
4. Use the Office Assistant/Microsoft Help 
5. Create Calendar Appointments 
6. Create Contacts 
7. Create Tasks 

Directions: 

1. Create a new mail message. 
2. Address the message to Mary Jane. 
3. Add a subject and type a brief note. 
4. Close the message before sending and save it to the Drafts Folder. 
5. Create a new Microsoft Word document. 
6. List the things you need to do at school tomorrow. Save it to your computer 

desktop. 
7. Open the saved Draft Message. 
8. Attach the Word document to the mail message. 
9. Print the email message. 
10. Create a new calendar appointment. 
11. Put on your schedule to watch West Wing on Wednesday at 9:00 p.m. Set a 

one-day reminder. 
12. Create a new task. 
13. Remind yourself to make popcorn before the show on Wednesday. Set a due date. 
14. Set the new task as high priority. 
15. Print the task. 
16. Open the Office Assistant/Microsoft Help. 
17. Ask the assistant how to create a Personal Distribution List. 
18. Print the topic. 
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Activity 2 - Outlook 2000 (e-mail) 

This activity will help you learn portions of Outlook 2000 (e-mail). Below is a list of 
skills that are covered in this activity. 

Outlook 2000 (e-mail) skills: 

I. Create, send, reply, forward and recall messages 
2. Save and delete messages 
3. Create and manage folders 
4. Use the office Assistant/Microsoft Help 
5. Create calendar appointments 
6. Create contacts 
7. Create tasks 

Directions: 

1. Create a new folder and place it in the Inbox. Name it "Student 
Communications." 
Add the shortcut to your Outlook Bar. 

2. Create a new mail message. Address it to Joe Navigator (check the Global 
Address List). 

3. Type "Mary Jane's progress at school" in the subject area. 
4. Inform Joe of Mary Jane's progress over the pass few weeks. 
5. Send the message. 
6. When you receive the reply, add your comment and send the message back. 
7. Move Joe Navigator's original reply message to the Student Communications 

folder. 
8. Create a new calendar appointment. 
9. Schedule a time next week to meet with the school counselor regarding Mary 

Jane's progress. 
10. Set a two-day reminder. 
11. ·Print a detailed view of the calendar appointment. 
12. Create a new task. 
13. Remind yourself to get Mary Jane's grades complied before your meeting with 

the counselor. 
14. Set a due date. 
15. Ask the Microsoft Office Assistant how to create a new Contact. 
16. Print and read the topic. 
17. Add Joe Navigator to your contacts 

Joe N aviagtor 
E-mail: Jnavigator@lsp.net 

18. Print a detailed view of the new contact. 
19. Open the existing mail message, add a comment and in the body of the message 

request a reply. 
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UNIT SIX 

Overview 

The staff members will learn the Easy Grade Program to organize grades, attendance 

and student reports for management of student data. Training time will consist of a 

two (2) day inservices consisting of a total of five (5) hours at the beginning of the school 

year. 

Goal: The staff will learn to organize grades, attendance and student reports for 

management of student data. 

• Develop a class roster. 

• Create a new class and attendance. 

• Use the program to input grades. 

• Create a progress report. 

Easv Grade Pro Skills: 

I. Create a new class file. 

2. Import class list into a class. 

3. Save a class to a specified location. 

4. Open a saved class from a specified location. 

5. Enter a student list. 

6. Create grading scales. 

7. Create grading periods. 

8. Enter scores. 

9. Fill row/column 

10. Enter a class name for reports. 
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11. Enter assignments: description, points, weight and category. 

12. Use special scores. 

13. View window: students, scores, assignments, attendance and seating 

charts. 

14. Create a new seating chart. 

15. Enter attendance. 

16. Create a style for a report. 

17. Preview and print reports. 

18. Create comments. 

Timeline: 

I. Staff will be allowed five (5) hours ofinservice to be introduced to this program 

and to experiment with the many applications of this software. A two (2) day 

inservice will be conducted at the beginning of the school year with a follow-up 

after the first four (4) weeks for preparing progress reports. 

2. Activities will be sent home with the teacher to practice and to summit to the 

administrator a print out copy from each activity. 

Activities: 

The following activities will be provided for staff members to practice their skills at 

home, school, or the classroom. These activities were taken from the Lake Washington, 

Tahoma, and Auburn school districts staff development for technology and modified for 

beginning teachers in technology. 
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Activity 1 - Easy Grade Program 

This activity will help you learn portions of the Easy Grade Program. Below is a list 
of skills that are covered in this activity. 

Easy Grade Program skills: 

I . Create a new class 
2. Import class list into class 
3. Save a class to a specific location 
4. Use Help 
5. Enter a student list 
6. Create grading scales 
7. Create grading periods 
8. Enter a class name for reports 
9. View Windows: students, scores, assignments, attendance, seating charts 

10. Enter attendance 
11. Create comments 
12. Preview and print reports 

Directions: 

1. Create a new class. 
2. Choose Class name from the class menu to give a class name for reports. 
3. Choose class information from the class menu to enter your name for teacher name. 
4. Choose grading periods from the class menu to enter the current grading period. 
5. Choose grading scales to modify the grading scale to your specifications. 
6. Search for Help on "grading scales" from Help menu to determine the Lower cutoff 

for each grade. 
7. Choose comment from the class menu to Append or Insert (create) the following 

comments: 
• You are an outstanding student. 
• You have turned in all assignments. 
• You have not turned in all assignments. 
• You need to study more for tests. 

8. Search for Help on "importing" from the Help menu to review Importing and print 
these directions. 

9. Import or type in a student class list including student ID numbers. 
10. Save the class to a folder on the C: drive. 
11. Choose attendance codes from the class menu to edit or append codes. 
12. View the attendance window and enter attendance codes for a one week period. 
13. Save the Class to A: drive (3.5 floppy). 
14. Choose student data from the style menu to modify what to include in reports. 
15. Choose attendance sheet from the report and print for this class showing the 

attendance for one week. 
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Activity 2 - Easv Grade Program 

This activity will help you learn portions of the Easy Grade Program. Below is a list 
of skills that are covered in this activity. 

Easy Grade Program skills: 

I. Create a new class 
2. Import class list into class 
3. Save a class to a specific location 
4. Enter a student list 
5. Enter a class name for reports 
6. Enter assignments: description, points, weight, category 
7. Enter scores 
8. Fill row/column 
9. Use special scores 

I 0. View Windows: students, scores, assignments, attendance, seating charts 
11. Create a style for reports 
12. Preview and print reports 

Directions: 

1. Create a new class. 
2. Choose Class name from the class menu to give a class name for reports. 
3. Choose class information from the class menu to enter your name for teacher name. 
4. Import or type in a student class list including student ID numbers. 
5. View the assignments window and enter at least three assignment descriptions 

assign points, weight, and category (Hint: search for help on these items from the 
help menu to find out how to assign points, weight, and category). 

6. View score window and highlight column heading of first assignment, choose fill 
column to give all students a perfect score for the first assignment (Note: You must 
know the points of a perfect score). 

7. View score window and highlight the first student choose Fill Row from the edit 
menu to excuse the student from all assignments. 

8. View the score window and enter assignment scores for the rest of the students. 
9. Create a group report that includes the following by modifying the student data, 

assignment data, general report and screen preferences under the style menu. 
10. Print the report 
11. Save the class to a folder on the C: drive. 
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Activity 3 - Easv Grade Program 

This activity will help you learn portions of the Easy Grade Program. Below is a list 
of skills that are covered in this activity. 

Easy Grade Program skills: 

I. Save a class to a specific location 
2. UseHelp 
3. View Windows: students, scores, assignments, attendance, seating charts 
4. Create a new seating chart 
5. Preview and print report 

Directions: 

I. Search for Help on "Seating Charts" from the Help menu to review seating charts. 
2. View the seating charts window and create desks for all students. 
3. Select the seating preferences for the class menu as follows: 

• First name 
• Last name 

• 25 desk 

• Teacher's desk visible 

• 5 desk per row 
• Snap to grid 

• Grid visible 

• 80 Horizontal 
• 60 Vertical 

4. Organize the desks 5 rows of 5 desks each by clicking and dragging. 
5. Place the teacher's desk in front of the class. 
6. Choose print setup for the File menu and change the paper orientation to 

Landscape. 
7. Look at the seating chart in preview. 
8. Move the desks if they are not properly located on the page (Hint: use the zoom 

mode on the seating chart toolbar to shrink the view). 
9. Save the class to the A: drive (3.5 floppy). 

10. Print the seating chart report. 
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UNIT SEVEN 

Assessment 

This section gives the staff an opportunity to evaluate their current technology skills. 

By taking the survey, the feedback will help the school to organize the inservices for the 

school year. At the end of the year, staff members will assess their technology skills that 

they developed throughout the year. 

Technology Plan Snrvey 

The purpose of this survey is to gather feedback and recommendations for technology 
planning what will improve learning. 

Name of staff member: 
~~~~~~~~~~~~~~-

I. Does the school have a technology plan as part of its learning plan? 

2. What is the primary purpose of computers in schools? 

3. Explain how computers are used in the school? 

4. Explain how you use computers for productivity? 

5. What additional resources do you need to help students better meet these 
standards? 

6. What additional resources are needed to help with developing lessons plans that 
integrate technology into the learning process? 

7. What percentage of your classroom time do you actively use computers? 

8. What professional development will help you use computers to improve learning? 

9. Have you attended any professional development training for enhancing computer 
use in the classroom? If yes, explain what training you have had. 

I 0. What can the district do to help you more effectively use technology in the 
classroom? 
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Staff Use of Technology Self-Evaluation 

Please judge your level of achievement in each of the following competencies. Check the 
number which best reflects your current level of skill attainment. This tool is designed to 
help understand your current level of skills with computer technologies and to plan for 
professional development. 

1. Basic Computer Use 
_Level 1 - I do not use a computer. 
__ Level 2 -1 use the computer to run a few specific, pre-loaded programs. 
_Level 3 - I run two programs simultaneously and have several windows open 

at the same time. 
_Level 4 - I trouble-shoot successfully when basic problems with my computer 

or printer occur. I learn new programs on my own. I teach basic 
operations to my students. 

2. File Management 
_Level 1 - I do not save any documents I create using the computer. 
_Level 2 - I select, open and save documents on different drives. 
_Level 3 - I create my own folders to keep files organized and understand the 

importance of a back-up system. 
_Level 4 - I move files between folders and drives and I maintain my network 

storage size within acceptable limits. I teach students how to save 
and organize their files. 

3. Work Processing 
_Level 1 - I do not use a word processing program. 
_Level 2 - I occasionally use a word processing program for simple 

documents. I generally find it easier to hand write most written 
work I do. 

__ Level 3 - I use word processing program for nearly all my written 
professional work: memos, tests, worksheets and home 
communication. I edit, spell-check and change the format of a 
document. 

_Level 4 - I teach students to use word processing programs for their written 
communication. 
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4. E-Mail 
_Level 1 - I have an e-mail account but rarely use it. 
_Level 2 - I send messages using e-mail mostly to district colleagues, friends 

and family. I check my e-mail account on a regular basis and 
maintain my mail folders in an organized manner. 

_Level 3 - I incorporate e-mail use into classroom activities. I use e-mail to 
access information from outside sources. 

_Level 4 - I use e-mail to request and sent information for research. 

5. Research/Information-Searching 
_Level 1 - I am unlikely to seek information when it is in electronic formats. 
_Level 2 - I conduct simply searches with the electronic encyclopedia and 

library software for major topics. 
_Level 3 - I have learned how to use a variety of search strategies on several 

information programs. 
_Level 4 - I have incorporated logical search strategies into my work with 

students, showing them the power of such searches with various 
electronic sources to locate information which relates to their 
questions. 

6. Internet 
Level 1 - I do not use the Internet. 
Level 2 - I access school and district websites to find information. I follow 

links from these sites to various Internet resources. 
_Level 3 - I use lists oflnternet resources and make profitable use of Web 

search engines to explore educational resources. 
_Level 4 - I contribute to my school or district websites. I teach students how 

to effectively use the resources available on the Internet. 

* This scale was borrowed and modified with permission from the original 
Mankato Schools scale. 
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CHAPTER FIVE 

SUMMARY, CONCLUSIONS AND RECOMMENDATIONS 

Summary 

The purpose of this project was to develop a staff development program in technology 

skills training for selected secondary schools. To accomplish this purpose a review of 

related literature and research was conducted. Additional related information from 

selected sources were obtained and analyzed. 

Conclusions 

Conclusions reached as a result of this project were: 

I. Successful implementation of educational technology is based on teachers' 

attitude and acceptance toward computers. 

2. Staff development in technology must be ongoing, giving teachers time to 

practice, collaborate with others, and have accessibility at home and school. 

3. Computer literate teachers will take technology to the next level in education, 

therefore, staff members who have become more competent with technology 

will integrate technology into their curriculum. 

Recommendations 

As a result of this project, the following recommendations have been suggested: 

1. Identifying and implementing a variety of technology skills will best serve the 

need of each staff member in technology competency. 
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2. Administrators must take leadership in developing and supporting a quality 

technology training program for the staff. 

3. Understanding and recognizing the staffs' individualized needs in technology 

are essential to successfully implementing a technology training program. 

3. Teachers must take on the responsibility in getting the training they need in 

technology in order to master technology skills and be able to successfully 

integrate technology in their classrooms. 
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